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Chapter 1
Introduction
This section includes the following topics:
■ Utilities Included with the System

■

Starting the Utilities

Utilities Included with the System
This guide describes the following software utilities provided with the SLS system:
■ Remote Notification, which can tell you
■ RealMonitor, a Sinter application utility
when builds finish or problems occur, by
that enables you to collect (“log”) and
pager or e-mail.
review data about SLS system.
■

Remote Status, which checks the status of
the SLS system from a remote system.

■

Build Report, which extracts selected
information from the build packet and the
states.blog file in a spreadsheet format.

■

LogManager, a stand-alone Sinter
application utility program that lets you
view and search the contents of 3DL
Session Log files.

Build Report can be used immediately upon installation. Remote Notification and Remote Status
require some setup and configuration to be useful. The sections that follow describe each utility in
more detail.
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Starting the Utilities

Starting the Utilities
All of the utilities can be found on your Windows Start menu. To use the menu, select Start
Programs SLS System. The SLS System menu appears. Select a utility from the menu to start
it.
.

Chapter 2
RemoteNotifyPro
The RemoteNotifyPro utility allows you to notify one or more people via email when certain
events occur during the use of the sPro or Sinterstation system. It also can send a daily summary
report of events via email.
You can also have events trigger application programs or operating system commands. The
RemoteNotifyPro utility runs on the sPro or Sinterstation system. For notification via email, it
requires access to an SMTP mail server.
RemoteNotifyPro is a 3D Systems’ licensed application.
This section includes the following topics:
■ Starting the Remote Notification Utility
■ Installing RemoteNotifyPro License
■

Setting Up Remote Notification
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Starting the Remote Notification Utility

Starting the Remote Notification Utility
To start the Remote Notification utility, select Start SLS System Remote Notify. The
RemoteNotifyPro window appears.

Figure 1. RemoteNotifyPro Window

Activating and Deactivating the Utility
When you start the application, it is active, meaning it will send notifications. If you want to
temporarily disable notification while the application is running (for example, to make changes to
notification options), select File Deactivate. The words “Not Active” appear in the status bar at
the bottom of the window. To activate the utility again, select File Activate. Closing the
RemoteNotifyPro window automatically deactivates the utility. The window must be open (or
minimized) and the status set to Active in order for notifications to be sent.
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Setting Up Remote Notification
Before you can use the RemoteNotifyPro utility, you must perform several setup tasks. These
include selecting events that you want to be notified of, and entering the email addresses, and mail
server name to be used. Optionally, you may enter application programs that you want the
program to execute when an event occurs.

Settings and Data Files
The RemoteNotifyPro utility stores two kinds of information: settings files and data files. Settings
files store your choices of what events should cause someone to be notified. They use the .cfg
extension. Data files store names, and e-mail addresses. They use the .dat extension. Both types of
files are stored in the c:\dtm\config\RemoteNotifyPro directory.
You can have several settings files, but each accesses the same Address Book for e-mail
addresses.
When you initially start the utility, the settings file is untitled. After you start entering setup
information, you should save a settings file by selecting File Save or clicking .
You can load an existing settings file by selecting File Open or clicking .

✏ The Remote Notification utility keeps a list of recently-used settings files on the File menu.
Events and RemoteNotifyPro Actions
Remote notification is based on events and consequences. Consequences are the actions the
RemoteNotifyPro utility takes when a specific type of event occurs.
The events that can trigger an action are:
■

Alarms, warnings, and advisories: You can select different consequences for each of these
three types of events.

■

Inert reached: The system has inerted the process chamber.
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Stages and completion: You can select consequences for the system’s entry into each of the
three build stages (warm-up, cool-down, and build) as well as for build completion.

✏ Remote Notify will send a build complete message whether the build ends normally or due to a problem.
■

Z heights reached: You can select actions for the system to apply when the build reaches
specific Z heights. See “Installing RemoteNotifyPro License” on page 18 for more
information.

For each type of event, you can send an email to one or more persons:
■ In addition to notification of an individual event, you can also have a Daily Summary Report
of all currently selected events emailed to selected individuals.
Optionally, you can have the system run one or more program(s) or any combination of the above.

Selecting Consequences
The RemoteNotifyPro window contains a table with a row for each type of event. In each row,
you can select a check box for each type of action. For example, the following figure shows the
RemoteNotifyPro window with e-mail selected for Alarm events and Daily Report is enabled.
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Setting Up Remote Notification

Figure 2. RemoteNotifyPro Window with Consequences Selected

In addition to selecting the check boxes, you must set up the details of each action as described in
the sections that follow.

Printing Settings
You can print the table of settings and actions shown in the RemoteNotifyPro window by
selecting File Print or clicking .
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Setting Up E-Mail Notification
The Remote Notification utility can send e-mail to a different list of recipients for each event type.
The e-mail message that the utility sends contains the type of event, the name of the computer
sending the message, the text of the message, and a time stamp. For example:
Warning from HiQ
The process chamber door is not latched
Thu, Jul 16 11:11:39 2009
To use e-mail notification, you must:
1. Set up e-mail.
2. Create an address book.
3. Create mailing lists.
The sections that follow describe each of these steps in detail.

Setting Up E-Mail Server Information
To set up e-mail, select Edit Mail Setup. The Mail Setup dialog box appears. Enter appropriate
values in the two text boxes.
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Figure 3. Mail Setup Dialog Box

SMTP Server is the name of your mail server.
“From” Address is the address that will appear in the From header on the e-mail sent by the
Remote Notification utility. This can be any text string and does not have to be a valid e-mail
address. If it is not a valid e-mail address, recipients will not be able to reply to e-mails sent by the
utility.

✏ You may want to enter the address of a system administrator or SLS system technician so that replies go to
someone equipped to handle them, or you may want to enter a nonexistent address so that no replies are
possible.
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Creating an Address Book
An address book is a list of addresses to which the Remote Notification utility can send e-mail.
To create an address book for your company:
1. Select Edit Address Book.
The Edit Address Book dialog box appears.
Click the Add button to
display a dialog box
where you can add
names and e-mail
addresses

Select a name, then
click the Edit button to
change a name or email address

Figure 4. Edit Address Book Dialog Box

2. For each e-mail address you want to add to the book, complete the following steps:
a. Click the Add button.
A secondary Edit Address Book dialog box appears.
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Enter the name
that will appear
in the address
book list

Enter the
actual e-mail
address
Figure 5. Secondary Edit Address Book Dialog Box

b. Enter appropriate information in the Display Name and Email Address text boxes.
c. Click the OK button.
The new address book entry appears in the Edit Address Book dialog box, listed by
display name.
3. To make changes to any address book entry, select the entry in the list on the Edit Address
Book dialog box, then click the Edit button.
The Edit Address Book Entry dialog box appears. Make any needed changes in the text boxes,
then click the OK button.
4. To delete an entry, select the entry in the list, then click the Delete button.
5. When you are finished making changes to your address book, click the OK button on the Edit
Address Book dialog box.
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Creating Mailing Lists
You can create a different mailing list for each event type. This list defines the e-mail addresses to
which mail will be sent if an event of that type occurs. To create a mailing list:
1. Double-click an event checkbox in the Email column of the Remote Notify window.

Double-click
this cell to
display the
Alarm Mailing
List

Figure 6. Displaying the Mailing List

The Email list dialog box appears.
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Select
a name
Click
button

Figure 7. Sample Mailing List Dialog Box

✏ You can also display the list by selecting the event checkbox and then pressing the right mouse button, or by
selecting the event checkbox and selecting Edit Mailing List.

2. Select a name in the Address Book list and click

to move it to the To list.

3. Repeat step 2 until all desired names are in the To list.
4. If desired, click the Send Test Message button.
5. Click the OK button.
6. Create E-Mail lists for all desired events.
7. Create E-Mail list for the Daily Report (if desired). Although you can have the Daily Report
sent out multiple times per day, you can only have one Email list.

Software Utilities Guide

14

Setting Up Remote Notification

Setting up Z-Height Triggers
You can use Z-Height triggers to select points during a build at which you want specific actions to
occur. To set up Z-Height triggers:
1. Select EditHeight Triggers. The Edit Z Height Triggers dialog box appears.

Figure 8. Z Height Dialog Box

2. Type a number in the New Z Height text box and click the Add button. This number is a
relative Z height, measured from the beginning of each stage. Each Z height that you enter
will trigger a Z Height Reached event and produce the action that you have selected for that
event.
3. Repeat Step 2 until you have entered all desired Z heights
4. Click the OK button.
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Optional Program Setup
You can have the Remote Notification utility launch programs or issue commands when specific
types of events occur.
To use these features, you must:
1. Create a program book.
2. Create program lists.
The sections that follow describe each of these steps in detail.

Creating a Program Book
A program book is a list of programs and/or system commands that you can have the Remote
Notify utility launch. Programs and system commands are treated the same by the Remote Notify
utility.
Click the Add button to
display a dialog box where
you can add program
names and commands

Select a name,
then click the
Edit button to
change a name
or command

Figure 9. Edit Program Book Dialog Box
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3. For each program you want to add to the book, complete the following:
a. Click the Add button.
A secondary Edit Program Book dialog box appears.
Enter name
to display in
program list
Enter command
line to run when
event occurs
Figure 10. Secondary Edit Program Book Dialog Box

b. Enter appropriate information in the Display Name and Command Line text boxes.
c. Click the OK button.
The new program book entry appears in the Edit Program Book dialog box, listed by
name.
4. To make changes to any program book entry, select the entry and then click the Edit button.
The Edit Program Book Entry dialog box appears. Make any needed changes then click the
OK button.
5. To delete an entry, select the entry in the list, then click the Delete button.
6. When you are finished making changes to your program book, click the OK button on the Edit
Program Book dialog box.
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Creating Program Lists
You can create a different program list for each event type. This list defines the programs that will
be launched if an event of that type occurs. To create a program list:
1. Double-click a cell in the Run Program column of the Remote Notification window.
The Program List dialog box appears.

Select a program
from the list
Click this button
to move the
program to the
Run list

Figure 11. Sample Program List Dialog Box

✏ You can also display the list by selecting the cell and then pressing the right trackball button, or by selecting
the cell and selecting Edit Program List.

2. Select a name in the Program Book list and click
3. Repeat step 2 until all desired names are in the To list.
4. Click the OK button.

to move it to the Run list.
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Installing RemoteNotifyPro License
1. Start the Remote Notify utility by selecting StartSLS SystemRemoteNotifyPro.
If the Remote Notify is not found on the Start menu, go directly to dtm/bin/RemoteNotifyPro
to launch the utility. You may want to create a shortcut to the utility on your desktop or pin to
your Start menu.
2. If no license exists for RemoteNotifyPro or the license has expired, you will see the following:

3. Select No. The following menu appears

4. Click OK.
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5. Save this text file into the dtm/license directory.

6. Send the FD_Hostid_xxxx file to 3D Systems to obtain a license file.
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7. Place the license.dat file from 3D Systems into the dtm/license directory.

Chapter 3
Session Log Files
This section describes session log files; “consolidated” log files created by the Sinter application
that contain copies of all the separate error and parameter log files Sinter generates. Session log
files have a “.3DL” extension (for “3D Log”) and are also called “3DL files.”
The topics in this section describe the contents of 3DL files and how and when Sinter generates
them.
■ About Session Log (3DL) Files
■ Summary – How Log Sessions Work
■

LogManager and Session Log Files

■

Session Log File Contents

■

How Sinter Generates Session Log Files

■

Session Log File Disk Space
Management

■

Session Log File Descriptions

Software Utilities Guide

22

About Session Log (3DL) Files

About Session Log (3DL) Files
Log files can help you and 3D Systems refine and troubleshoot your SLS process. Sinter creates
many separate log files during and between builds. They all have different file formats, names,
and storage locations. Sinter also creates session log (.3DL) files to make it easy for you to access
the data in these multiple log files.
At the start or end of a build, Sinter copies the various log files created during the previous session
into a 3DL file automatically or on demand so you can view, search, and manage them in
LogManager.
Sinter copies log files to a...
■ Build session log file after an build completes or is terminated.
■

Manual Ops session log file between builds, just before a new build starts.

✏ If you ever need to work with 3D Systems Customer Support to troubleshoot your SLS process, you can
send your session log files for to review instead of gathering sending many different log files.

Sinter stores 3DL files in two folders on your installation drive by default: \dtm\3DLogs\Build
and \dtm\3DLogs\ManualOps.

LogManager and Session Log Files
✏ This topic is a general discussion. For complete details, see Chapter 5, “LogManager” .
Run the LogManager utility to open, view, and search the contents of session log files.
LogManager is a stand-alone program; you can run it even if Sinter is not running. To open or
view any log file in LogManager, click a 3DL file in the \dtm\3DLogs\Build or
\dtm\3DLogs\ManualOps folder, or, run LogManager, then choose File > Open ... or
File > Recent Build ...
You mainly use LogManager to do the following:
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■

View the contents of the individual log files a 3DL file contains.

■

View historical parameter graphs with RealMonitor event notations. (RealMonitor License
required).

■

Manage log file disk space by specifying how many 3DL files to keep, based on the file date
or folder size.

■

(If Sinter is running…) initiate a new 3DL file for the current Build session or Manual Ops
session on demand

✏ You need to run Sinter at least once to create the first 3DL file automatically.
Session Log File Contents
Build session and Manual Ops session log files contain copies of the individual log error and
monitoring log files that Sinter generates during and between builds. They also contain copies of
the configuration and .ini files in use when the session log file was generated.
The two tables below list the file names of the individual error and monitoring log files that
Sinter copies into session log files. They also list the different types of data these log files contain.
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Error Log Files
Error Log File Name

Contains...

Slicer.tlog

Slicer program (Slicer.exe) runtime errors

Plcif.tlog

PLC interface program (Plcif.exe) runtime errors

ScanIF.tlog

Scanner interface program (Scanif.exe) runtime errors

DSPIF.log
(Sinterstation Pro SLS systems only)

Digital Signal Processor interface program (Dspif.exe) runtime errors

Packetio.log
(Should always be empty, if not, contact
3D Systems Customer Support)

Errors in:
■ material configuration (.cfg) files; <material_name>.cfg
■ machine configuration files; machine.cfg
■ Build packet files; <build_name>.bpz

Monitoring Log Files
Monitoring Log Files

Contains...

States.blog

All build, part, and scale parameter values

RealMonitor log (.rmt) file
<MMDDYYbuild_name>.rmt

The values of all parameters RealMonitor is monitoring

RealTimeCal.log

Data for every Real Time Calibration event. For each calibration attempt, it logs
whether calibration was successful or failed-and how much adjustment, if any,
was applied—and why.

RealTimeCalData.log

Summarizes each Real Time Calibration adjustment made

OfflineCal.log
(Only for offline calibration)

Records how much adjustment was applied during any Offline Calibration—and
why the adjustment was applied

Bds.tlog

All commands sent to the beam delivery system by the scanner interface software

Data.log

A summary of each build, including the time the build finished, the material used,
and the part and feed temperature set points.
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How Sinter Generates Session Log Files
While Sinter is running, it logs data to the individual log files in Session Log File Contents above
regardless of whether a build is running or not. These individual log files are stored in folders
separate from the \dtm\3DLogs session log file folder.
On the other hand, Sinter starts a new session log file when a build starts, then closes the session
when the build terminates. The log files generated during a build are called the Build Session
Log. In between two builds, there will also be sets of log files generated. These log files are called
the Manual Ops Session Log.

Log Sessions
When a new session starts, individual log files are overwritten. This means individual log files on
disk only contain data from the most recent session. Log data from older sessions resides in the
(date/time-stamped) 3DL files to which individual log files are copied at the end of each session.
When a (Build or Manual Ops) log session closes, Sinter automatically adds all individual log
files generated in the session that just closed to one compressed date/time-stamped session log
(.3DL) file. It then stores the 3DL file in either:
■

\dtm\3DLogs\Build if a build (“Build session”) just ended, or

■

\dtm\3DLogs\ManualOps if a “Manual Ops session” just ended; i.e., a build just started

Session log file names
When a build starts, Sinter closes the Manual Ops Log Session and creates a .3DL file with the
file name
machine ID_YYYY-MM-DD_HH.MM.SS_manual_ops<index#>.3DL

When a build finishes, Sinter closes the Build Log Session and creates a .3DL file with the file
name:
machine ID_YYYY-MM-DD_HH.MM.SS_build packet name<index#>.3DL
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Where:
machine ID is the SLS system’s serial number by default. However, if you entered a custom
Machine Name in your RealMonitor Setting Preferences window, that will be the machine ID.
YYYY-MM-DD_HH.MM.SS is the date and time when the Log Session started. (Time is in

24-hour format.)
<index#> is a number appended to the file name to prevent duplicate file names.

✏ A 3DL file name can be up to 256 characters long.
Generating Session Log Files Manually
Sinter generates 3DL files automatically when to start and finish a build. However, you might also
want to use the LogManager utility to generate a 3DL file manually if:
■ When a build is terminated abnormally.
■

When user wants to generated a 3DL file before a session is finished.

Software Utilities Guide

27

Summary – How Log Sessions Work

Summary – How Log Sessions Work
This topic summarizes the session log file actions Sinter performs when:
■ Sinter starts
■

A build starts

■

A build finishes

■

Sinter ends normally

■

Sinter ends abnormally

When Sinter starts
■

A new Manual Ops session starts (if Sinter terminated normally the last time you ran it...).
Any existing individual log files are overwritten. (The data in all of the previous individual
log files was copied/saved in a 3DL file.)

When a build starts
Sinter does the following when a build starts:
1. Closes the Manual Ops session.
2. Creates a [...]_manual_ops.3DL log file.
3. Starts a new Build Log session, overwriting data in the individual log files collected during
the Manual Ops session it just closed.

When a build finishes
Sinter does the following when a build finishes:
1. Closes the Build session.
2. Creates a [...]_build packet name.3DL log file.
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3. Starts a new Manual Ops session, overwriting data in the individual log files collected during
the Build session it just closed.

When Sinter ends normally
Sinter does the following when it ends normally:
1. Closes the Manual Ops session (which started after the last build ended).
2. Creates a [...]_manual_ops.3DL log file.

When Sinter ends abnormally
When Sinter terminates abnormally, the next time your run it, it does the following:
1. Creates a [...]_manual_ops.3DL file or a [...]_build packet name.3DL file—depending on
the state it was in when it terminated abnormally.
2. Sets the Sinter Termination Status in the 3DL file to Abnormal.

✏ Sinter Termination Status is shown in the Summary window box on LogManager’s RealMonitor tab. See
“Summary Windows – (RealMonitor Tab Only)” on page 53.

Session Log File Disk Space Management
Typical session log files range in size from 100 KB to 1000 KB (1 MB), so you must remove old
3DL files periodically. Use the Diskspace Manage tab in the RealMonitor utility’s Preferences
dialog to set limits on the size and age of 3DL files on disk. (See RealMonitor “Setting
Preferences” on page 42.)
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Session Log File Descriptions
This section describes the contents of build and manual ops session log files. It also shows how
Sinter names automatically-generated 3DL files.

Build session log files
Sinter generates a build session log file when a build terminates. The build 3DL file contains all
the log file data generated during that build. Build session log file names are of the format:
<buildname>MMDDYYYYHHMMSS_Build.3DL

where buildname is the build packet filename.

Manual Ops session log files
Sinter generates a manual ops session log file when a build starts. The manual ops 3DL file
contains all the log file data generated between two builds; specifically between the a Build End
event and a Build Start event.
Manual ops session log file names are of the format:
<buildname>MMDDYYYYHHMMSS_ManualOps.3DL

where buildname is the build packet filename for the build that started.

Chapter 4
RealMonitor
This section describes RealMonitor, a Sinter application utility that enables you to collect (“log”)
and review data about SLS system. RealMonitor starts when you start Sinter and stops when you
exit Sinter. It logs data continually by default while Sinter is running, but you can pause or stop
logging (then restart it) at any time.
With RealMonitor, you can watch data plots update in real time and compare parameters while
your SLS system operates. After a build, use LogManager to view and analyze the data logged by
RealMonitor and other Sinter software modules in the log files the Sinter application creates.

✏ See “LogManager” on page 46 for further information.
This section includes the following topics:
■ RealMonitor License

■

Printing Plots

■

Logging Data with RealMonitor

■

Setting Preferences

■

Comparing Parameters in RealMonitor

■

Creating a Session Log File Manually

■

Zooming in X and Y
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RealMonitor License
RealMonitor and LogManager are licensed applications. You only need one license—a
RealMonitor license—to make full use of both RealMonitor and LogManager.
You can log data about your system before you install a RealMonitor license, but you must install
a license before you can view data plots in RealMonitor and LogManager.
RealMonitor logs data whether you have a license or not. So, even if you don’t have a license, you
can still send log files to 3D Systems Customer Support if you need help resolving problems.

Installing a RealMonitor License
To install a RealMonitor license, click the Enable button on the RealMonitor toolbar as shown in
Figure 12 below.
Click to open the license dialog

Figure 12. RealMonitor, before enabling a license

You can also install a RealMonitor license by running the 3D Systems software licensing utility
from the Windows Start menu. Choose Programs > SLS System > Install 3D License, then
select RealMonitor in the License For drop-down list.
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✏ If you install 3D Systems LS Software and a RealMonitor license on a separate, stand-alone computer (to
run the Build Setup application), you can view the parameter data plots in LogManager’s RealMonitor tab.

Click Next to display your SLS system’s Computer ID in the License window, along with a
blank text box for your RealMonitor license Activation Password. Contact 3D Systems
Customer Support by email or phone and provide your Computer ID. 3D Systems will provide
you with a RealMonitor license Activation Password specific to your SLS system. Enter Your
Activation Password in the License window.

What a RealMonitor License Enables
■

Without a RealMonitor license – you can use RealMonitor to log data during and between
builds (which it does by default when you run Sinter), create consolidated 3DL Session Log
Files, and manage the amount of disk space 3DL files use. In LogManager, you can open a
3DL file, then browse, search, and filter text data in individual Sinter log files without a
RealMonitor license.

■

With a RealMonitor license – you can do everything above—plus view live data plots in
RealMonitor and historical data plots in LogManager. The data plots show parameter values
as a function of time or build z-height. These graphs include vertical lines showing when, or at
what z-height, various build events occurred. You also get the option to overlay a moving
average trend line.
In addition, with a RealMonitor license you can export data to a delimited file, as well as use a
dynamic-link library (DLL) to access logged data in real time from a custom application
program.

Replacing a RealMonitor License
The license activation password will persist after an upgrade of the SLS system software.
However, you will need to contact 3D Systems Customer Support to get a new password if you do
either of the following:
■

Reinstall your operating system
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Change your network configuration; (for example, if you replace your network card)
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Logging Data with RealMonitor
The RealMonitor utility starts automatically when you start the Sinter application. When you
enter Build or Manual Ops mode in Sinter, RealMonitor opens a new Build or Manual Ops
session (3DL) log file and starts logging data to many individual Sinter log files. It then copies the
individual log files into time-stamped 3DL files at the end of the session. (See Chapter 3, “Session
Log Files” for further details.)
One of the most important individual log files that gets copied into a 3DL file is the RealMonitor
Log (.rmt) file. There are two types of .rmt files; one for Build data and one for Manual Ops data.
This section describes both types of .rmt files, and various ways you can start and stop logging
data to them.

RealMonitor (.rmt) Log Files
Two Sinter log files store the values of all parameters RealMonitor can display on its data plots.
They are:
<BuildPacketName>.rmt – for the current Build session
ManualOps.rmt – for the current Manual Ops session
These two .rmt log files (and the other individual Sinter log files) are copied into the
time-stamped 3DL session log file created at the end of each Build session and Manual Ops
session.
RealMonitor automatically logs data to <BuildPacketName>.rmt while Sinter is in Build mode.
However, it does not automatically log data to ManualOps.rmt data in Manual Ops mode. To log
data to ManualOps.rmt, you must click the Start button (see Figure 13., “Start, Stop and Pause
buttons,” on page 35) when Sinter is in Manual Ops mode.
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Starting and Stopping Logging to a RealMonitor (.rmt) Log File
You can stop, pause, and restart logging data to either
Click these buttons to
of the two RealMonitor (.rmt) Log Files at any time
start, stop, or pause data
using the Start, Stop, and Pause buttons below the
logging to .rmt log files at
RealMonitor toolbar.
any time.
If you wish to start or stop logging to the current .rmt
file when a specific event occurs, you have several
Figure 13. Start, Stop and Pause buttons
events to choose from in the lists under Start Monitor
At and End Monitor At (below the RealMonitor toolbar).
After you select a Start or End event, specify the build height at which you want RealMonitor to
begin watching for the event to occur.
Choose an event to Start Monitoring At or End
Monitoring At from these drop-down lists.

Enter the build height at which you want
RealMonitor to start watching for the selected
Start or End event to occur.
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Comparing Parameters in RealMonitor
The two parameter data plots RealMonitor displays allow you to view and compare SLS system
parameters in real time. You can also scroll back in time (or z-height)—all the way back to the
start of the current build—to compare parameters earlier in the build. For each parameter section,
you select a parameter in the Plot Parameter list and the system graphs it on the right.

✏ To compare more than two parameters at once, or to compare parameter values in older builds, use
LogManager’s RealMonitor tab. You can compare more than two parameters by running multiple instances
of LogManager and selecting different parameters to view in each instance. Then, for ease of comparison,
use LogManager’s time synchronization function to synchronize the data displayed in each instance. (See
“LogManager Log Tabs” on page 57 for more information.)
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Parameter Graphs and Plotting Options
Parameter graphs show a variety of data about a build.
Warm-up stage (pink)
Pause (grey)

Build states are color-coded; cooldown (blue) and
build preparation
(yellow) are not
shown

Build stage
(green)
Machine is
idle (white)

Event (change in build
parameter); see Events

Setpoint graphed in red alongside
the parameter value, shown in black
Figure 14. Sample Parameter Graph

Plot Parameter Options
You have four parameter graph display options in RealMonitor’s Plot
Parameter box:
Against. selects the x-axis units. Choose one of the following:
■

Time Stamp (default), the actual times data points were logged

■

Time Elapsed, the time elapsed since the start of build when
data points were logged

■

Stage Height Z, the z-height when data points were logged.
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Actual Value displays parameter actual value curve.
Set Point displays parameter set point value curve.
Average Over [number of data points] displays parameter moving average curve. Use this
moving average curve to help detect trends you might not see on the Actual Value curve. The
moving average is calculated for the most recent number of data points. The default = 120 data
points. You can change the moving average number of data points in the RealMonitor
Preferences window. (See “RM Settings Preferences Tab” on page 44.)
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Events
RealMonitor tracks a number of events during a build. Events are marked with a vertical line, and
an abbreviation (above the line). The line and abbreviation are also color coded. The following
table shows the monitored events:
Abbreviation

Event

Description

PM

Pause Monitor

Monitoring was paused.

SR

Sample Rate

The sampling rate was changed by the user.

BP

Build Parameter

A build parameter was manually adjusted.

PP

Part Parameter

A part parameter was manually adjusted.

BM

Build Mode

The build mode was manually adjusted

AD

Add/Delete Parts

Parts were manually added or deleted

PC

Prime Cycle

A prime cycle was run.

NS

Next Stage

The system was manually directed to move to the next
stage of the build.

TM

Terminate

The build was manually terminated.

AL

Alarm

A system alarm occurred.

R1

Calibration on

The system began real-time calibration.

R0

Calibration off

The system stopped real-time calibration.

RA

Real-time
adjustment

A calibration adjustment occurred.
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Zooming in X and Y
You can change the visible portion of either of the two graphs displayed in the
RealMonitor window by clicking the Zoom X or Zoom Y toolbar button.
After clicking Zoom X or Zoom Y, click on the graph where you want the zoom centered, then
use the left and right mouse buttons to zoom in and out.
Use the mouse wheel, if available, to scroll within the graph. If you place the mouse inside the
plot, the graph scrolls along the X axis. Placing the mouse on the left side of the plot allows you to
scroll along the Y axis.

✏ The Zoom X button changes the x-axis zoom on both graphs. The Zoom Y button on changes the y-axis of
the graph you clicked on.

Setting the Y Scale Range Click the Y-Scale toolbar button to display a dialog box
with fields for minimum and maximum values of the Y axis for either of the two
parameter graphs. (See Figure 16 below.)
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Figure 16. Y Scale Dialog Box

Click the Reset button to return to the original zoom settings.

The Zoom Factors button reports the current zoom factors the x-axis
(same for both graphs) and the separate zoom factors for the upper
(Y1) and lower (Y2) graphs.

Zooming in X and Y
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Printing Plots
Click the Print toolbar button to display a dialog box of printing options. The system prints the
two current graphs to the printer you select.

Setting Preferences
Click the Pref toolbar button to display a the RealMonitor Preference window. Set your
preferences on any or all of the four Preference window tabs described below, then click OK to
save them.

General Preferences Tab
Use this tab to enter company
and machine information,
select the display units, and
choose the date and time format
used to time stamp the data that
RealMonitor logs.

✏ The Machine Serial Number is
read-only. It is set by
3D Systems.
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Diskspace Manage
Preferences Tab
Use this tab to specify
limits—in number of files,
megabytes (MB), or Days—
on the amount of disk space
session log files can occupy.
You can set three types of
limits on both Build session
files and Manual Ops session
files. To set a limit, select can
not exceed, then enter (or
scroll to select) the limit
value.
Number of 3DL files Keeps
the last m 3DL files on disk,
where m is between:
■ 10 and 10000 Build session log files; default m = 100 files
■

5 and 10000 Manual Ops session log files; default m = 5 files

When the number of session log files on disk equals the limit m, the oldest (based on time
stamp) is deleted when a new file is added.
Total 3DL file size Keeps up to n MB of session log files on disk, where n is between:
■ 500 MB and 1000000 MB (1000 GB) Build session log files; default n = 1000 MB (1
GB).
■

500 MB and 1000000 MB (1000 GB) Manual Ops session log files; default n = 500 MB.
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When the amount of disk space used by session log files exceeds the n MB limit, the oldest
file(s) (based on time stamp) are deleted until disk space used drops below n MB.
3DL file life age Keeps up to d Days of 3DL files on disk, where d is between:
■ 10 and 10000 Build session log files; default m = 100 files
■

5 and 10000 Manual Ops session log files; default m = 5 files

When the number of days exceeds the limit d, any files with a time stamp older than d Days
are deleted.

RM Settings Preferences Tab
Use this tab to set the following:
Average Data Points The default number of
data points over which RealMonitor calculates
the moving average plotted on parameter graphs.
(See “Average Over [number of data points]” on
page 38.)
Hint text stay for The number of seconds hint
text remains visible when you pointer hovers a
RealMonitor toolbar button.
Color Settings Lets you set different colors for
the Actual Value, Average Value, and Setpoint
curves in RealMonitor parameter graphs. Click
the
button to choose a color.
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RM Events Preferences Tab
Use this tab to select the Events you want
RealMonitor to show. The events you select are
highlighted on RealMonitor’s parameter graphs
with vertical lines and two-letter abbreviations.
For event descriptions, see “Events” on page 39.

Creating a Session Log File Manually
Use RealMonitor’s W3DL toolbar button to manually create a session log (3DL) file for
the current log session. When you click the W3DL button, RealMonitor does the
following:
■ Closes the current 3DL file if a session is in progress and writes the file to disk, time-stamping
it with the current time.
■

Opens a new (Build or Manual Ops) 3DL file (depending on which mode Sinter is in) and
begins logging data in this new 3DL file.

Chapter 5
LogManager
This section describes LogManager, a stand-alone Sinter application utility program that lets you
view and search the contents of 3DL Session Log Files. You launch LogManager separate from
Sinter. It runs in a window with several tabs; one for each log file Sinter generates.

✏ LogManager replaces the older RealMonitor Viewer and BrowseLog utilities. It handles all of their
functions and adds some new ones.

You need a RealMonitor license to take full advantage of LogManager. You can view and search
text data stored LogManager without a license. With a license, you can also view parameter data
plots of RealMonitor log file data.
This section includes the following topics:
■ RealMonitor License for LogManager
■ Synchronizing Multiple LogManager Windows
■ About LogManager
■

Starting LogManager

■

LogManager Window

■

LogManager Menus

■

LogManager Log Tabs

■

Time-Tracking Log File Data

■

Time Zone Localization

■

Opening Individual Log Files

■

Comparing Parameters in
LogManager

■

Printing Plots

■

RealMonitor Log Viewing Options
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RealMonitor License for LogManager
LogManager and RealMonitor are licensed applications. You only need one license—a
RealMonitor license—to make full use of both LogManager and RealMonitor.
You can log data about your system before you install a RealMonitor license, but you must install
a license before you can view data plots in LogManager and RealMonitor.
See “RealMonitor License” on page 31 for a complete information on the RealMonitor license for
LogManager, including:
■ Installing a RealMonitor License so you can access all functionality in LogManager
■

What a RealMonitor License Enables in the LogManager utility

■

Replacing a RealMonitor License if necessary

About LogManager
LogManager enables you to do the following:
■ Open Build and Manual Ops Session Log Files (3DL files) and view their contents.
■

Open and view individual Sinter error and monitoring log files, such as RealMonitor log
(.rmt) files, Slicer (.tlog) files, and States log (.blog) files.

Unlike the RealMonitor utility, you don’t need to run Sinter to start LogManager.
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Starting LogManager
You can start LogManager from your Windows Start menu by choosing Programs > SLS System
> LogManager. You can also start LogManager by double-clicking one of the following log files
in Windows Explorer:
■ Build or Manual Ops 3DL file in ..\dtm\3DLogs\Build or ..\dtm\3DLogs\ManualOps
■

RealMonitor (.rmt) log file in ..\dtm\logs\RMData

■

States log (.blog) file in ..\dtm\Logs

Windows should launch LogManager with the selected log file loaded.
LogManager will run on your SLS system computer while Sinter and RealMonitor are running—
or not. Or, you can run LogManager on a stand-alone computer separate from the SLS system.

Running Multiple Instances of LogManager
LogManager opens Session Log Files (“3DL files”) one at a time, but you can run multiple
“instances” of LogManager (i.e., “open several LogManager windows”) on a single computer.
This is useful if you want to:
■ View several 3DL files at once
■

View one 3DL file several different ways

In addition, LogManager lets you “synchronize” multiple instances of LogManager to make it
easier for you to compare data values that were logged at the same time and date. See
“LogManager Log Tabs” on page 57 for further information.
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LogManager Window
After you start LogManager, a single window opens (Figure 17 below). If you open a 3DL session
log file (using File > Open), several “log tab” buttons appear along the top of the window. Each
tab button corresponds to an individual log file stored in the 3DL session log file you opened. (If
you open an individual log file instead of a 3DL file, only one log tab button appears.)
Log Tab buttons

Action Bar

Menus
Summary:
Machine
information

Summary:
Build
information

Main
Display

Figure 17. LogManager window (showing RealMonitor tab view for RealMonitor log (.rmt) file)
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LogManager Window Elements
Each LogManager window element shown in Figure 17 is described in this section.

Log Tab Buttons
Use Log Tab buttons to view all available data in the currently loaded individual log file or 3DL
session log file. When you open a log file in LogManager, you only see Log Tab buttons
corresponding to the data in that log file.
3DL session log files typically have more Log Tab buttons than individual log files. However,
Manual Ops 3DL files have fewer Log Tab buttons than Build 3DL files, because Manual Ops
3DL files do not contain RealMonitor data.
See “LogManager Log Tabs” on page 57 for further information.

Menus
See “LogManager Menus” on page 55.

Action Bar Buttons
The Action Bar buttons operate on the data your currently viewing in the Main Display. For
example, buttons on the RealMonitor tab’s Action Bar enable you to zoom and scale parameter
data plots. Action Bar buttons on other Log Tabs enable you to manipulate your view of text data;
for example, Search, Collapse, and Expand text data entries.
See “LogManager Log Tabs” on page 57 for descriptions of Action Bar buttons in the various Log
Tabs.

Main Display
This is where the actual file content is displayed. There are various Main Display formats in
LogManager. The one you see depends on the type and content of the file you are viewing.
The following describes the different types of Main Displays you see when viewing different
types of files in LogManager:
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■

When viewing RealMonitor Log (.rmt) file data, you see data plots in the Main Display on the
RealMonitor tab.

■

When viewing States Log (.blog) file data—or data from other log (.tlog) files containing
ISO-formatted time-stamped entries—the Main Display shows clickable time-stamped data
item entry lists along with the contents of the selected entry. You can select, browse, and
search through time stamped entries in these files. This Main Display format is used on the
following Log Tabs: StatesLog, Realtime IR Cal, IR Adjustment, PLCIF, ScanIF, Slicer,
DutyCylAdj, and BDS. (See Figure 18., “StatesLog tab for States Log (.blog) file,” on page 52
for an example of the StatesLog Main Display.)

✏
■

ISO (International Standards Organization) time stamp format is
YYYY-MM-DD_HHMMSS —> Message.

The Main Displays for other types of files you can view in LogManger, such as .ini files and
machine and build data files, are either tabular, or simple text listings. These Main Display
formats are found on the following Log Tabs: IR Cal Ini, IR Offline Cal, Machine Overlay,
and Build History.
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LogManager Window

Expand/Collapse buttons
(view more/less in Summary)

Search
button

Summary
(data for
selected
entry on
the left)

Main
Display

Currently selected entry
(data displayed in Summary on the right)
Figure 18. StatesLog tab for States Log (.blog) file
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Summary Windows – (RealMonitor Tab Only)
Two Summary windows at the top of the RealMonitor tab Main Display list identifying
information for the machine and build that generated the log file you are viewing.

Summary: Machine information
■

Platform Type – the SLS system model on which this data was logged:
■

Sinterstation HiQ or HiQ +HS

■

Vanguard or Vanguard HS, or

■

Sinterstation 2500plus

■

Machine Name – the Machine Name you entered on the General Preferences Tab in
RealMonitor.

■

Machine Serial Number – the (read-only) Machine Serial Number shown on the General
Preferences Tab in RealMonitor. (The serial number is set by 3D Systems.)

■

Customer Name – the Company Name you entered on the General Preferences Tab in
RealMonitor.

■

Material Name – the default material selected when this log file was generated. (This value is
in the material configuration file, material_name.cfg.)

■

Material File Name – the material configuration file name, material_name.cfg, for the
default material selected when this log file was generated.

■

Sinter Version – the Sinter application software version that generated the log file you are
viewing.

■

Build Setup Version – the Build Setup application software version that created the build
packet “Build Packet Name” above. If you are viewing a Manual Ops session 3DL file, the
Build Setup Version is always “NA” (Not Applicable).
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Slicer Time Stamp – the time stamp for the start of the Slicer software module as recorded in
the log file.

Summary: Build information
■

Build Packet Name – the name of the build packet that generated this log file. If you are
viewing a Manual Ops session 3DL file, the Build Packet Name is always “Manual Ops.”

■

Build Finish Status – build termination status; “Normal” if the build finished normally;
“Abnormal” if the build started, but did not finish normally.)

■

Start Log At – the time RealMonitor started logging to this log file.

■

End Log At – the time RealMonitor stopped logging to this log file.

■

RM Start Log Event – the event that triggered the start of RealMonitor logging. (See
RealMonitor build “Events” on page 39.)

■

RM End Log Event – the event that triggered the end of RealMonitor logging. (See
RealMonitor build “Events” on page 39.)

■

RM Sample Rate – the number of seconds between consecutive RealMonitor log entries (or
“samples”) in this log file.

■

RM Config File – the name of the active RealMonitor configuration file when this log file
was generated.
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LogManager Menus
Commands on each LogManager menu are described below.

File Menu
■

Open ... opens 3DL files, or individual log files such as Real Monitor file, States Log File etc.

■

Recent Files ... lists the filenames and time stamps of the 10 most recently viewed 3DL file(s)
in this instance of LogManager.

■

Export – saves the log file data you are currently viewing to tab-delimited ASCII text file
(requires RealMonitor License).

■

Report – generates a custom build report after a build is complete. The available options
include build parameters, part parameters and build times.

■

Print – prints the data in the Log Tab Main Display you are currently viewing. If you are
viewing parameter graphs on the RealMonitor tab’s Main Display, you can print both graphs
to a printer or a bitmap file.

■

Preference – opens LogManager’s Preference window. The settings in this window are a
subset of those in RealMonitor’s Preference window. See “Setting Preferences” on page 42 in
Chapter 4, “RealMonitor” for preference setting descriptions and instructions.

■

Exit – exits the currently selected LogManager instance. (All other running instances remain
open.)

Options Menu
The time tracking and synchronization commands on this menu help you compare data in
individual log files within one 3DL session and across multiple 3DL sessions.
■ Time Tracking – automatically selects the same entry time stamp in every Log Tab, based on
your current entry selection. See “LogManager Log Tabs” on page 57.

Software Utilities Guide

■

56

LogManager Menus

Time Synchronization – automatically sets the same data view settings in all open, running
LogManager windows, based on the data view settings in the currently selected LogManger
window. This works whether you’re viewing the same 3DL file in multiple windows, or
different 3DL files in multiple windows. See “Synchronizing Multiple LogManager
Windows” on page 70.

Windows Menu
These window resizing commands act on the currently selected instance of LogManager:
■ Default Size – set the LogManger window to its default size.
■

Maximize – enlarges the LogManager window to fill the display area.

■

Minimize – shrinks the LogManager window to a title bar at the bottom of the display.

Help Menu
■

About ... opens a window showing the LogManager software version number along with
3D Systems contact information.

■

Help ... displays the online documentation for LogManager.

■

License – displays the license password entry window for a RealMonitor License.
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LogManager Log Tabs
This section describes the views of log data you see under each Log Tab button in LogManager.
The Action Bar and Main Display, which vary from one Log Tab to the next, are described
separately for each Log Tab in LogManager.

RealMonitor Tab
The RealMonitor tab contains an Action Bar with buttons for manipulating the appearance of the
two parameter graphs in its Main Display. It also contains Plot Parameter controls for changing
the plotting options on the two graphs.
The RealMonitor tab displays the time-stamped contents of a RealMonitor log file; file name
format MMDDYYbuildname.rmt. RealMonitor log files contain the values of all parameters
RealMonitor acquires between the start and end of logging during a build.

RealMonitor Tab Action Bar Buttons
Use RealMonitor tab Action Bar buttons to adjust the parameter plot zoom, view Display Build
Properties, and scroll the parameter graphs forward and back.
■ Zoom X – click this button, then click inside a parameter graph to
interactively change the x-axis zoom factor for both the upper and lower
graphs. (See “Zooming in X and Y” on page 40 for further information.)
■

Zoom Y – click this button, then click inside a parameter graph to interactively change that
graph’s y-axis zoom factor. (See “Zooming in X and Y” on page 40 for further information.)

■

Y-Scale – click this button to open the Y-Scale dialog box (see Figure 16 on page 41)
and enter the upper and lower y-axis ranges for the two currently displayed parameter
graphs. (See “Zooming in X and Y” on page 40 for further information.)

■

Reset – click to return to the original zoom settings.
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Zoom Factors – shows the current zoom factors for the x- and y
axes on both parameter graphs. (See “Zooming in X and Y” on
page 40 for further information.)

RealMonitor Tab Main Display
The RealMonitor tab Main Display (see Figure 19 on page 59) contains two Summary windows;
one for Machine information (on the left) and one for Build information (on the right). (See
“Summary Windows – (RealMonitor Tab Only)” on page 53 for further information.)
Below the Summary windows in the RealMonitor tab Main Display are two parameter graphs
with Plot Parameter controls for setting plotting options.

✏ The parameter graph and plotting options for the graphs in LogManager’s RealMonitor tab Main Display are
the same as those for the parameter graphs in the RealMonitor utility. See “Parameter Graphs and Plotting
Options” on page 37 in Chapter 4, “RealMonitor” for details and instructions.
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Machine Summary

LogManager Log Tabs

Build Summary

Plot (A)
controls

Plot (A)

Plot (B)
controls

Plot (B)

Background color change
indicates build stage transition

Parameter value
curve vs. time or z-height.
Hover pointer over curve to
View Pinpoint Data

Figure 19. RealMonitor tab Main Display in LogManager

Build Events
indicator lines.
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StatesLog (.blog) File Tab
The StatesLog tab contains an Action Bar with buttons for manipulating the time-stamped states
log data entries listed in its Main Display window(s).
The StatesLog tab displays the contents of the log file, States.blog, which contains all Build, Part,
and Scale & Offset parameter values.

StatesLog Tab Action Bar
■

Search – opens Search States Log window. (See Figure 20 on page
61 below.) Use this window to find and select items to search for
(“Search Items”) in the states log file. The search starts when you
click OK to close the Search States Log window. The search results are shown in the
StatesLog tab Main Display.

■

Next/Previous – search down (forward)/up (backward) for the next occurrence of the Search
Items currently set in the Search States Log window (shown in (See Figure 20 on page 61
below).

■

Collapse/Expand – minimize (Collapse) or maximize (Expand) the amount
of text data shown in the right Main Display pane for the currently selected
states log Item/Time Stamp.
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Enter search string to search
for items in list below you want
to add to the Search Items

61

LogManager Log Tabs

Select a Search Item, then click Delete
to remove it from the Search Items list.

Select an
item in this
list, then
click Add to
add it to the
Search
Items list on
the right.

List of
Search
Items

Click OK to
start search
Figure 20. Search States Log window in StatesLog tab

StatesLog Tab Main Display
Description Main Display; (Short List) shows list of log file entries by Item # and time stamp on
the left; right pane shows contents of single currently selected log file entry data. You can Search,
Expand, and Collapse this. (List All) shows table of log data with Item #, Time Stamp, and data
columns.
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Select an
Item/
Time Stamp
in list on the
left to display
Item’s data
contents in
the right.

Figure 21. StatesLog tab Main Display

LogManager Log Tabs

Contains either:
(a.) The data
contents for the
currently
selected Item/
Time Stamp on
the left, or,
(b.) The data
contents for the
Search Items
found.
(Expanded
view shown.)
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Time-Stamped Log (.tlog) File Tabs
Time-stamped log (.tlog) tabs in LogManager all have the same Action Bar buttons and Main
Display. The Action Bar buttons change your view of the time-stamped text log data listed in the
Main Display. A Search button is also included.
Time-stamped Log Tabs include:
.tlog File Tab

Displays Log File

Log File Contains

Realtime IR Cal

RealTimeCal.log

Data for every Real Time Calibration event. For each calibration
attempt, it logs whether calibration was successful or failed—and how
much adjustment, if any, was applied—and why.

IR Adjustment

OfflineCal.log

For offline calibration only: Records how much adjustment was
applied during any Offline Calibration—and why the adjustment was
applied

PLCIF

Plcif.tlog

PLC interface program (Plcif.exe) runtime errors

ScanIF

ScanIF.tlog

Scanner interface program (Scanif.exe) runtime errors

Slicer

Slicer.tlog

Slicer program (Slicer.exe) runtime errors

Bds.tlog

All commands sent to the beam delivery system by the scanner
interface software

DutyCylAdj
BDS

Time-Stamped Log (.tlog) Tabs Action Bar
■

Short List – displays the time-stamped log file data in a left and right pane,
similar to the StatesLog Main Display shown in Figure 21 on page 62. You
select an Item/Time Stamp on the left to display its contents on the right.

■

List All – displays the time-stamped log file data in a scrollable table in a single pane.
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Search – lets you search for a text string in the log
file. Enter the text string in the search text box, then
click the Search button. All Items containing the
search string appear in the Main Display. Click the drop-down arrow on the Search button to
change the search direction and turn case-sensitivity on or off.
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Time-Stamped Log Tabs Main Display
The Main Display you see on time-stamped log tabs depends on whether you have the Short List
or List All action bar button selected.
Short List Main Display

List All Main Display

Figure 22. Time-Stamped Log Tabs Main Display
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Machine Status File Tabs
Machine Status file tabs in LogManager all have the same Action Bar buttons and Main Display.
The Action Bar buttons change your view of the text data listed in the Main Display. A text
Search tool is also included.
Machine Status file tabs include:
.tLog File Tab

Displays Log File

Log File Contains

IR Cal Ini

IRCal.ini

Current IR sensor scale values from latest IR calibration

IR Offline Cal

IROfflineCal.log

Manual offline IR calibration results

Machine Overlay

machine.ovrl

Machine overlay file listing

Machine Status File Tabs Action Bar
■

Sel All – Select all text in file; click again to deselect all.

■

Search – Enter search text in the box; click Search to
find all occurrences of the search text in the file.
Search results are shown in the Main Display.
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Machine Status File Tabs Main Display

Figure 23. Machine Status File Tabs Main Display

LogManager Log Tabs
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Build History File Tab
Unlike other Log Tabs in LogManager, the Build History tab has no Action Bar; only a table of
build history data in the Main Display (Figure 24 on page 69). Each row in the table contains the
build history data for one build. The top row always shows the history data for the most recent
build.
The columns in the build history table list the following data for each build:
End Build Time

Time-stamp for the Build End event

Build Height

Total height of the build; number of layers X layer thickness

Part Temp-0.25”

Part bed temperature recorded by the Part IR sensor 0.25 inches into the build

Left Temp-0.25”

Left feed temperature recorded by the left feed IR sensor 0.25 inches into the build

Right Temp-0.25”

Right feed temperature recorded by the right feed IR sensor 0.25 inches into the build

Part Temp-End

Part bed temperature recorded by the Part IR sensor at the end of the build

Left Temp-End

Left feed temperature recorded by the left feed IR sensor at the end of the build

Right Temp-End

Right feed temperature recorded by the right feed IR sensor at the end of the build

Material

Default material selected in Sinter when this build was run
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Build History Tab Main Display
End of Build time-stamp

Part bed and feed temperatures

One row of data
per build

Figure 24. Build History File Tab Main Display

Default material
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Time-Tracking Log File Data
Select Options Menu > Time Tracking to automatically select the same entry time stamp in every
Log Tab. This helps you compare data in different log files that was recorded at the same time.
To see how this works, try the following with Time Tracking selected:
1. Click on a time-stamped log file entry in the current Log Tab.
2. Click on a different Log Tab button; one for a log file that has time-stamped entries.
3. Note that the same entry time stamp is selected in the new Log Tab.

Synchronizing Multiple LogManager Windows
Select Options Menu > Time Synchronization to automatically sets the same data view settings
in all open, running LogManager windows, based on the data view settings in the currently
selected LogManager window.
Time Synchronization helps you compare data, whether you’re viewing the same 3DL file in
multiple windows, or different 3DL files in multiple windows.

✏ You must have log files loaded in two or more LogManager windows to use this feature.
When you select Options > Time Synchronization, LogManager matches the views of the data
items below in all open LogManager windows with your view of these items in the currently
selected (“focused”) LogManager window.
■ View data – The specific Log Tab currently in view, such as the RealMonitor tab or StatesLog
tab.
■

X Scale - The x scale (zoom factor) of the data plots on the RealMonitor tab

■

Y Scale - The y scale (zoom factor) of the data plots on the RealMonitor tab.

■

Currently focused time – If you have multiple LogManager windows open and to view:
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■

The same 3DL file – the focused time stamp in the focused LogManager window sets the
focused time stamp in all other open LogManager windows viewing that same 3DL file.

■

Multiple 3DL files – the 3DL files in all open LogManager windows are set to the same
time into the build as the 3DL file in the focused LogManager window.

If you select a different LogManager window, then select Options > Time Synchronization in
that window, it now becomes the focused window that the other open windows track.
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Time Zone Localization

Time Zone Localization
The date and time stamps in the log file can be recorded at different time zones. The date and time
stamps in the file name will always be in the time zone which has been recorded. However, we
will have an option to display the date and time in either the local time or original time within the
LogManager program. This option should be set in the preference section and should be
persistent.

Opening Individual Log Files
As we mentioned before the Log Manager can open individual log files such as Real Monitor Log
files, States Log Files, or other error log files. There will only be two cases you will need to open
individual files:
■ pen legacy log files. Those log files was created before this change can be opened as
individual log file use this utility.
■

pen individual log files during a log session. In this case, the 3DL file has not yet been
generated. When the user chooses to open this type of log file, a copy of the log file is opened
instead of the original so that the logging can continue without interruption. Therefore the file
you opened will be a snapshot of the time that you opened it. Any new log data after you
opened the file will not be refreshed into the display.

Comparing Parameters in LogManager
While LogManager’s RealMonitor Tab and the RealMonitor utility in Sinter both display the
same parameter data plots. This enables you to view and compare two machine parameters over
time.
However, if you want to compare more than two parameters, you can launch additional instances
of LogManager, load the same log file in each window, then select different parameters to view in
each window’s RealMonitor tab.
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Printing Plots

✏ See “Parameter Graphs and Plotting Options” on page 37 and “Events” on page 39 in for further information
about comparing parameters on RealMonitor parameter graphs.

Printing Plots
Select File > Print in the LogManager window to print both two parameter graphs currently
displayed in the RealMonitor tab. You can print the graphs to a printer or to bitmap file.

RealMonitor Log Viewing Options in LogManager
You can use LogManager to view log files (.rmt files) generated by RealMonitor from past builds.
LogManager also has other features for viewing data that are not available in RealMonitor.

Loading an Individual RealMonitor Log (.rmt) File
As an alternative to loading an entire Build session 3DL file, you can load an individual
RealMonitor log (.rmt) file in LogManager if you just want to view RealMonitor parameter
graphs. Use File > Open in LogManager open an individual RealMonitor log (.rmt) file to view.
RealMonitor data files are stored in the \dtm\logs\RMData folder by default.

✏ The Action Bar buttons on the RealMonitor tab remain inactive until you load a RealMonitor log file, (or a
Build session 3DL file that contains a RealMonitor log file).

✏ See Figure 19., “RealMonitor tab Main Display in LogManager,” on page 59.
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View Pinpoint Data
To get more specific information about a point
on a data plot on the RealMonitor tab, hover
your mouse pointer over the point, or click on
the point:
■ When you pause your mouse pointer over a
point on the plotted graph, information about
the data point appears in a pop up window,
including its value (y), time (x), stage height
and set point, as well as an average value
created by averaging the current point with
some number of preceding points (defined by
the Average Data Points preference option).
If an event is associated with the data point,
the event description also appears.
■

Figure 25. Hover pointer to view pinpoint data

When you click on a point on the curve, green horizontal and vertical lines pinpoint your
location, and the application displays a popup window with information about the selected
point. When you have selected a point in this way, you can move the selection forward or
backward through the graph with the arrow keys on your keyboard.

Display Build Properties
Click the Property button in on the RealMonitor tab’s Action Bar to display a dialog box
with information about the build whose data you are viewing. Basic information such as
the platform, machine name, and material type is displayed at the top of the window,
with details such as build and part parameters displayed in tabs at the bottom.
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Click tabs to
display different
categories of
information

Print the data or
save it to a file

Figure 26. Properties Window

Exporting Data Files
If you have an RealMonitor license installed on the computer that LogManager is running on, you
can export data from LogManager. Select File > Export from the LogManager menu to save data
from the currently loaded log file to a text file.

Copyright and Corporate Identity
© 2009 by 3D Systems Corporation. All rights reserved. Subject to change without notice. This
document is copyrighted and contains proprietary information that is the property of 3D Systems
Corporation. The licensed user, in the name of whom this document is registered (the “Licensed
User”) does not have the right to copy, reproduce, or translate this document in any way or to any
media without the prior written consent of 3D Systems Corporation. No copies of the document
may be sold or given to any person or other entity.

Improvements
3D Systems may (but shall not be obligated to) make improvements to this document from time to
time. However, the Licensed User acknowledges that at any time after the expiration of the date of
issuance, 3D Systems may institute a periodic charge or fee payable by the Licensed User in
return for ongoing receipt of improvements. It is the responsibility of the Licensed User to
provide 3D Systems with current information as to its name and address. The Licensed User also
undertakes to notify 3D Systems promptly in the event that it considers any of the data contained
in this document to be incomplete or erroneous in any respect, in connection with Licensed User's
particular use or generally.

FCC Notice
This equipment has been tested and found to comply with the limits for a class A digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection
against harmful interference when the equipment is operated in a commercial environment. This
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to radio

communications. Operation of this equipment in a residential area is likely to cause harmful
interference in which case the user will be required to correct the interference at his own expense.
Changes or modifications not expressly approved by 3D Systems could void your authority to
operate this equipment.
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Limitations of Warranty and Liability

Limitations of Warranty and Liability
This information is provided by 3D Systems for the convenience of its customers. It is
believed to be reliable, but NO REPRESENTATIONS, GUARANTEES OR WARRANTIES OF
ANY KIND ARE MADE AS TO ITS ACCURACY, FITNESS FOR A PARTICULAR USE OR
THE RESULTS TO BE OBTAINED THEREFROM. The information is based in whole or in
large part on laboratory work and does not necessarily indicate performance in all conditions.
Notwithstanding any information provided by 3D Systems or its affiliates, the customer remains
fully responsible for determining which federal, state or local laws or regulations, or industry
practices are relevant to activities in which it engages, as well as assuring that those laws,
regulations or standards are complied with under actual operating conditions, and 3D Systems
undertakes no responsibility in these areas.
IN NO EVENT WILL 3D Systems BE RESPONSIBLE FOR DAMAGES OF ANY
NATURE, INCLUDING SPECIAL OR CONSEQUENTIAL DAMAGES, RESULTING
FROM THE USE OF OR RELIANCE UPON THIS INFORMATION. THE CUSTOMER
ASSUMES ALL RISK RESULTING FROM THE USE OF THIS INFORMATION.
Customers use of the materials that follow is an acknowledgment of its agreement to the
foregoing. Any customer not wishing to be bound should return this material to 3D Systems.
Nothing contained herein is to be considered as permission, recommendation, nor as an
inducement to practice any patented invention without permission of the patent owner.

Trademarks and Registered Trademarks
SLS, Sinterstation, and DuraForm are registered trademarks of 3D Systems Corp.
SLS, HiQ, Vanguard, CastForm, LaserForm, SinterScan, OptiScan, Opti-Scale, and RealMonitor
are trademarks of 3D Systems Corp. Other trademarks are the property of their respective owners.
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